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Lesson 4 — Banking in QuickBooks Lesson Objectives

Lesson Objectives

To learn how to record expenses paid through a chequing account
To learn how to record money being moved from one account to another
To demonstrate the steps to perform a reconciliation

To learn how to locate specific transactions using Find and filters

A A A

To demonstrate how to integrate banking transactions through Bank Feeds
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Lesson 4 — Banking in QuickBooks Bank Accounts

Bank Accounts

Bank accounts in QuickBooks are set up on your Chart of Accounts and are intended to track each transaction that involves
your real bank account. Bank accounts in QuickBooks can also be used in the Write Cheques window to create printable
cheques.

It is important that each transaction involving your bank account, such as deposits, bank drafts, cheques, etc. be entered
properly into QuickBooks with the same amounts, identifying numbers and dates. The Bank Feeds feature can help you do
this by downloading transactions directly from your bank and credit cards.

QuickBooks also allows you to perform reconciliations, which is a way to compare your bank account in QuickBooks to the
bank statements sent to you by your bank. Through reconciliations you can ensure that what you've entered into
QuickBooks is accurate and reliable because it reflects the bank’s own official records.

To find a bank account:

1. Onthe Home page, click the Chart of Accounts.

2. From this list you can create new bank accounts in QuickBooks, view the current In-QuickBooks balance of bank
accounts, and open account histories of bank accounts.

Chart of Accounts

N i€ TYPE BA E TOTAL
< Petty Cash Bank 0.00 '
< Savings Bank 0.00
+ Accounts Receivable Accounts Receivable 44,662.93
+ Allowance for Doubtful Accounts Other CurrentAsset 0.00
< Construction in Progress Other CurrentAsset 0.00
<+ Employee Advances Other CurrentAsset 0.00
+ Inventory Asset Other CurrentAsset 29,271.70
<+ Retainage Receivable Other CurrentAsset 0.00
<+ Undeposited Funds Other CurrentAsset 4679.15
<+ Workin Progress (WIP) Other CurrentAsset 0.00
+ Accumulated Depreciation Fixed Asset 0.00
<+ Automotive Equipment Fixed Asset 0.00
< Buildings and Improvements Fixed Asset 0.00
< Construction Equipment Fixed Asset 50,269.68 v
Account ¥ | Activities ¥ | Reports ¥ Attach | [7]) Include inactive

3. Close the Chart of Accounts.

@ NOTES
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Lesson 4 — Banking in QuickBooks Entering a Cheque

Entering a Cheque

Cheques in QuickBooks represent the spending of money from a bank account. Cheques can represent handwritten
cheques, bank drafts, debit card charges and even cheques that you plan to print out of QuickBooks.

To write a cheque:

1. Inthe Banking area of the Home page click Write Cheques (or press CTRL+W).

Main Reports 2 oA
§) Crea Print Lat 3 ) 2 =
«» B B8 X teaCopy | g | |Pintlater O & e
Fiad New Save Delete oMemm-ze Print Attach Select Enter Clear Recalculate Reorder
- - File PO Time Spiits Reminder omeu'es
BANK ACCOUNT | (i TTITTS] v] ENDING BALANCE 148,909_30
NO 107

DATE | 08/16/2016 B

PAY TO THE ORDER OF - s 0.00
Dollars
ADDRESS
MEMO
Expenses $0.00 Items $0.00

ACCOUNT TAX | AMOUNT MEMO CUSTOMER:JOB BILLABLE?
A
v

VENDOR TAX CODE - 0.00 Edit

Save & Close Clear

2. Inthe Bank Account field, make sure the correct bank account is chosen.
3. Inthe Pay to the Order of field choose the payee.
4. Ifthe Open Bills Exist window pops up, you may choose to select bills to pay with the cheque.

5. Ifthisis a cheque you want to print later in a batch, select the “Print Later” checkbox. Cheques can also be printed
individually after being saved.

6. Enter an appropriate expense account to categorize the expense along with the tax the purchase was subject to.

7. Click Save & Close or click Save and then Print > Cheque to print the cheque out by itself.

[—1 NOTES
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Lesson 4 — Banking in QuickBooks Entering a Handwritten Check

Entering a Handwritten Cheque

Sometimes you need to write a cheque by hand on the spot for items or services you did not plan to purchase. QuickBooks
lets enter a record of handwritten cheques after they have been written.

To enter a handwritten cheque in the chequing account register:
1. Inthe Banking area of the Home page click Write Cheques (or press CTRL+W).

2. Ensure the proper account is selected in the Bank Account drop-down menu.

3. Clickin the Number field in the blank transaction and enter the number from the handwritten cheque. (If the number
field says To Print, uncheck the Print Later box on the toolbar.)

A
(2]
>

Main Reports

€» B @ X Qowerow G rmow § B O B W
Order

Find New Save Delete €3 Memorize Print Aftach  Select Enter Clear Recalculate Reorder
v v File PO Time Splits Reminder oS
BANK ACCOUNT | [ofiTeTTTaTe] v] enoing sacance  148,909.30
~ny
No. | 107

DATE T08M6/2016  EH

PAY TO THE ORDER OF - s 0.00
Dollars
ADDRESS
MEMO
Expenses $0.00 Items $0.00
ACCOUNT ! TAX | AMOUNT i MEMO ! CUSTOMER:JOB | BILLABLE?
A
v
VENDOR TAX CODE v 0.00 Edit

Save & Close clar

4. Enter the information from the handwritten cheque and assign it to the appropriate expense account and tax code.

5. Save & Close.

[—1 NOTES
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Lesson 4 — Banking in QuickBooks

Entering a Cheque to be Printed

Entering a Cheque to be Printed

QuickBooks also allows you to enter cheques and print them later in a batch.

To enter a cheque to be printed:

1. Inthe Banking area of the Home page click Write Cheques (or press CTRL+W).

2. Ensure the proper account is selected in the Bank Account drop-down menu.

3. (Clickin the checkbox next to Print Later to print the cheque later in a batch.

Write Cheques - Chequing

Main Reporis

¢ D a E 2@ CfeateaCopy

Find New Save Delete °Memorize

BANK ACCOUNT

Chequing -

s ] @ 9] &
Print Attach Select Enter Clear Recalculate
T File PO Time Splits

ENDING BALANCE

178,608.75

NO. TOPRINT
DATE  08/12/2016 E&

FAY TOTHE ORDER OF  Children’s Charities

v s 381.92

Three hundred eighty-one and 92/100* *** ****xxxxxx2xxxxxxxxxaxx2xx 22 x 22 x2Dolars

ADDRESS
MEMO
Expenses $381.92 Items $0.00
ACCOUNT TAY AMOUNT MEN CUSTOMER:JOB BILLABLE?
Charitable Co... ¥ [E ~ 381.92 v A
v
VENDOR TAX CODE v [ Edit
Save & Close Clear

w®

Reorder
Reminder

4. Inthe bottom half of the cheque, assign the expense it to the appropriate account and tax code.

5. Save & Close.

QuickBooks 2018 Student Guide



Lesson 4 — Banking in QuickBooks

Entering a Cheque to be Printed

Once you have a sufficient amount of cheques that need printing it is time to print them in a batch.

To print cheques in a batch:

1. Select File > Print Forms > Cheques.

2. Checkthe cheques you'd like to print, and uncheck those you'd not like to print.

BankAccount | [SfFERIIE]

“

Select Cheques to print, then click OK.
There are 2 Cheques to print for $381.92.

4 i DATE PAY

m
m

First Cheque Number 106

Select Cheques to Print x

n L&
&5 Order cheques

v 081212016

Children’s Charities

381.92!

v 1012212016

The Phone Co.

0.00

Cancel

Help

Select All

Select None

3. Make sure the First Cheque Number is correct and if it is not, change it.

4. Click OK to print.

5. Confirm your printing options and click Print.
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Lesson 4 — Banking in QuickBooks Transferring Money Between Accounts

Transferring Money Between Accounts

The Transfer Funds feature in QuickBooks allows you to move money from one balance sheet account to another. These
transactions may reflect funds transfers from one bank account to another, or movement of money between chequing and
savings accounts or other types of bank accounts.

To transfer money:

1. From the Banking menu choose Transfer Funds.

Transfer Funds Between Accounts
@ Previous ® Next [ Save || @ Attach

Transfer Funds L ANSTES
08/16/2016 B

TRANSFER FUNDS FROM Cheguing v ACCOUNT BALANCE 148,909.30

TRANSFER FUNDS TO Ibﬂvings ~ | ACCOUNT BALANCE 0.00

TRANSFER AMOUNT

MEMO  Funds Transfer

Save & Close Clear

2. Inthe Transfer Funds From field choose the account you took money from.
3. Inthe Transfer Funds To field choose the account you transferred the money to.

4. Enterthe amount you transferred in the Transfer Amount field.

Transfer Funds Between Accounts

@ Previous P Next [E Save | | # Attach

Transfer Funds e NS
08/16/2016 ]

TRANSFER FUNDS FROM Chequing - ACCOUNT BALANCE 148,909.30

TRANSFER FUNDS TO | savings v | ACCOUNT BALANCE 0.00

MEMO Funds Transfer

Save & Close Clear

5. Click Save & Close.
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Lesson 4 — Banking in QuickBooks Reconciling Chequing Accounts

Reconciling Chequing Accounts

Your bank sends you a statement for each of your bank accounts each month. The statement shows all the activity in your
account since the previous statement:

Beginning balance: the sum of cleared transactions at the beginning of the statement period

Ending balance: the sum of cleared transactions at the end of the statement period

Amount of interest earned

Service charges

Cheques, bank drafts and debit card charges that have cleared the bank

Deposits made

A A A A A A

Other transactions affecting the balance of the account

To reconcile a chequing or savings account statement:
1. Fromthe Home page, click Reconcile.

2. Inthe Account drop-down menu choose the appropriate bank account from the list.

Begin Reconciliation

Select an account to reconcile, and then enter the ending balance from your account statement.

Account Chequing ~ | lastreconciled on 11/30/2016.
Statement Date 12/31/2016 B
Beginning Balance 7.247.01 What if my beginning balance doesn't match my statement?

Ending Balance

Enter any service charge or interest earned.

Service Charge Date Account

0.00 (03312011 E Interest & Bank Charges:Bank Ch... ~
Interest Earned Date Account

0.00 03/31/2011 £ -

Locate Discrepancies Undo Last Reconciliation Cancel Help

3. Inthe Statement Date field enter the closing date of the statement you wish to reconcile.
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Lesson 4 — Banking in QuickBooks Reconciling Chequing Accounts
4. Inthe Ending Balance field enter the ending balance from the statement you are using to reconcile.

5. If there were any service charges or interest earned during the statement period, enter it appropriately.

6. Click Continue.

The statement your bank sends you summarizing account activity for the month contains a list of cleared
transactions. The next step in the reconciliation process is to mark transactions in QuickBooks as cleared if they
appear on that statement and have matching amounts and dates.

To mark the transactions as cleared:

1. Inthe Cheques and Payments section of the window match the transactions with the cheques and payments on your
statement. Click on each transaction that appears on your statement. This marks the transaction as cleared.

2. Inthe Deposits and Other Credits section of the window click on each transaction that matches your statement to
mark the deposits as cleared.

Reconcile - Chequing

For period: 12/31/2016 Hide transactions after the statement's end date:
Cheques and Payments Deposits and Other Credits
VI DATE - CHQ # PAYEE AMOUNT VI DATE - CHQ # MEMO TYPE A
A
Y 11012016 73 Dobson’s Exter...[ 1,522.... . v 1211512016 PMT 45,000....
Y 11012016 74 Daniel's Tl
v 110412016 75 Blitz Marketing 892.50
Y 110412016 76 Rogers andC...| 450.00 <
7| Highlight Marked Mark All Unmark All GoTo Columns to Display...
Beginning Balance 7,247.01 Modify Service Charge 0.00
ltems you have marked cleared - Interest Earned 0.00
2 Deposits and Other Credits 269,000.00 Ending Balance 228,909.30
15 Cheques and Payments 47,337.71 Cleared Balance 228,909.30
Difference 0.00
[ Reconcile Now ‘ Leave

3. [Ifanytransactions appear on the statement, but are not in QuickBooks, click Leave, and enter them through the
proper forms. When you go back to the Reconciliation windows you should see them. You can also change any
transaction you see on the list by double-clicking it, changing the amount/date and resaving it to make it match the
statement.

4. When you are done with this process, the Difference in the bottom right corner should be zero. Click Reconcile Now.
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Lesson 4 — Banking in QuickBooks

Reconciling Chequing Accounts

5. Inthe Select Reconciliation Report window you can choose to display or print your reconciliation reports.

Select Reconciliation Report

Congratulations! Your account is balanced. All marked items
have been cleared in the account register.

Select the type of reconciliation report you'd like to see.

) Summary
O Detail

To view this report at a later time, selectthe Report menu,
display Banking and then Previous Reconciliation.

Display Print... Close

x

@ Notes
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Lesson 4 — Banking in QuickBooks Locating Specific Transactions

Locating Specific Transactions

You can use the QuickBooks Find command to search for specific cheques you’ve written. For example, suppose you want
to find all cheques greater than or equal to $500.00 that you've written during the current year.

To use the Find feature:

1. From the Edit menu choose Find then select the Advanced tab (or press CTRL+F).

2. Choose the filter you would like to use (this example shows the Amount, Account and Transaction Type filters). You
can choose multiple filters by setting one then choosing another from the list to the left.

T
= Find -0 X
Simple Advanced
CHOOSE FILTER Current Choices .
FILTER . R
Acconnt A . Ay FILTER : SETTO Reset
. ' Account Chequing
Aging @- ® >= (500.00
: Amount >=500.00
Amount Close
Billing Status Posting Status |Either
Class TransactionType Cheque Help
Zero Reorder ... |Hide
DATE ' TYPE UM NAME i ACCOUNT : MEMO : AMOUNT Go To
A
06/30/12017 CHQ 38 Kevin Ander...|Chequing -1,186.50 ' —
061712017 CHQ 35 Royal Bank [Chequing -4,200.00
06/01/2017 CHQ 34 Dobson's E... [Chequing -1,522.50 Export...
05/31/12017 CHQ 30 All Subs Chequing -13,811.52
05/31/12017 CHQ 31 Blitz Market...|Chequing -892.50
05/31/12017 CHQ 33 All Subs Chequing -12,075.00
051712017 CHQ 28 Royal Bank [Chequing -4,200.00
051512017 CHQ 24 Blitz Market...|Chequing -1,785.00 Number of
05152017  |cHQ 25 Roger's and...|Chequing 90000  Matches:54
v

Click the blue Find button to search. To clear your filters and start fresh click the Reset button.

4. From the table in the lower half of the window, double-click on the transaction you would like to view to open the
transaction.

5. Close the Find window.

[—’ NOTES
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Lesson 4 — Banking in QuickBooks Using Bank Feeds

Using Bank Feeds

Bank Feeds allow users to download bank and credit card transactions directly into their QuickBooks company file.

To use the Bank Feed feature:

1. From the menu bar select Banking = Bank Feeds - Bank Feeds Center. If this is your first time using the Bank Feeds
Center, click on the Add Account button in the top left corner and follow the prompt to set up your account
information.

4P AddAccount 55 Rules

BANK ACCOUNTS
Account Information LasTuPDRTE. O |

ANYTIME Financial

Account ending in **1244

b Qukocks ACEOUNTENOING 12t ENONG SALANCE Sors

Savings $17,910.19 nos

ANYTIME Financial $5,035.66 $1 7’91 0.19

Account ending in **1235 Over a year ago

In QuickBooks

Chequing $46,969.10 There are no transactions to review. Download Transactions
CREDIT CARD

QuickBooks Credit Card $45.00

Account ending in ***4321 Over a year ago Read messages from your bank

In QuickBooks 5] Messages Received (0) Send items to your bank

QuickBooks Credit Card $5420 &3 Payment Inquiry Responses (0) Transfers (0 of 0) Mesgages (0 of 0)
B Aers (0)
Manage your account
Contact your bank P .
Disable bank feeds

Get more from your bank. Activate bill pay services with ——

Bank fees may apply.

2. From the Bank Feeds window click the Transaction List button to view and process transactions. If this button says
Download Transactions, this means all previously downloaded transactions have already been posted to QuickBooks.
Press the Download Transactions button to download available transactions from the bank.
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Lesson 4 — Banking in QuickBooks Using Bank Feeds

3. Once the Transaction List is open, use the grid to enter additional information about the downloaded transactions
(payee, account the expense or deposit should be mapped to, transaction number, etc.).

4. To process transactions individually, use the drop-down menu in the Action column.

= Transactions List - O x

7 Transactions e, 1 quickaooks

Chequing
7
NEED YOUR REVIEW

Tell QuickBooks how to handle these bank transactions

starus Al v e Altypes| v | rrom [11/5/2003 | 1o [11/30/2003 | [ ShowBankmemo
|:| STATUS TYPE | DATE NO. | DOWNLOADED AS  PAVEE ACCOUNT | cLass PAYMENT DEPOSIT | ACTION

O I Rev DEP 11/5/2003 Funds Transfer Funds Transfer 5,000.00
(1] Rev  CHK 1111322003 ATM Withdrawal ~ ATM Withdrawal 200.00

(1] Rev  CHK 1111322003 239 1,207.75

(1] Rev  CHK 111412003 242 3,200.00

(1] Rev  CHK 1111412003 243 850.00

(1| Rev  DEP 1111512003 Deposit Deposit 2,080.11

[1] Rev  CHK  11/302003 Bank Severvice... 9.00

Batch Actions  ~
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Lesson 4 — Banking in QuickBooks Using Bank Feeds

5. To process multiple transactions at once place a checkmark in the far left column and use the Batch Actions drop-
down in the bottom left corner of the window.

= Transactions List -

7 Transactions ... +o auickaooks
Chequing

7

NEED YOUR REVIEW

Tell QuickBooks how to handle these bank transactions

status Al v Tve Altypes v From [11/5/2003 | To [11/30/2003 | [ SnowBankMemo

D : STATUS TYPE :DATE : NO. DOWNLOADED AS PAYEE ACCOUNT CLASS PAYMENT DEPOSIT ACTION
[0 Rev DEP  11/512003 Funds Transfer ~ Funds Transfer 5,000.00

O l Rev CHK  11/13/2003 ATM Withdrawal ~ ATM Withdrawal 200.00

[1] Rev  CHK 11132003 239 1,207.75

| Rev  CHK 111412003 242 62700 - Payroll E 3,200.00 Select
[ Rev  CHK 111412003 243 62400 - Interest | 850.00

| Rev  DEP 111512003 Deposit Deposit 40100 - Construc 2,080.11

I Rev CHK  11/30/2003 Bank Severvice... 15100 - Vehicles 9.00

6. Close the window when you are finished. After the transactions have been accepted, they will appear in QuickBooks as
transactions.
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Lesson 4— Banking in QuickBooks Review Activities

Review Activities

1. From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays the Open or Restore
Company window.

2. Select Restore a backup copy and click Next.

3. Select Local backup and click Next.

4. Inthe Open Backup Copy window, navigate to the appropriate directory.

5. Select the gblesson.qgbb file, and then click Open.

6. Inthe Open or Restore Company window, click Next.

7. Navigate to your directory.

8. Inthe File Name field of the Save Company File As window, type Lessong and then click Save.
9. Enterthe Password: QBDT2018!

10. Click OK when you see the message that the file has been successfully restored.

. Create a new bank account on the Chart of Accounts named Chequing 2. Give the account a $5,000 opening
balance with an as of date of 11/31/2018.

. Enter a handwritten cheque for $76.95 using the 10™ of the current month as the date using your Chequing
account. Use cheque number 107 and make the cheque payable to Jeanne’s Compu-Excellence for the performance of
some computer repairs. Categorize the expense as Computer and Internet Expenses. Enter "Standard” as the tax
code, and as a memo, enter “Charge for repairing my laptop.”

. Enter a cheque that is going to be printed out of QuickBooks for $150.28 using the 15" of the current month as the
date using your Chequing account. Check “Print Later” so that the cheque can be printed in a batch with other
cheques later. Make the cheque payable to Dan’s Auto Emporium. Categorize the expense as Auto and Truck
Expenses. Enter “Standard” as the tax code, and as a memo, enter “Oil change, wheel alignment and tune-up of
company car.”

. Enter a debit card charge by opening the Write Cheques. Select your Chequing account if it isnt selected already.
If “Print Later” is checked, uncheck it, and in the cheque number field enter "DEBIT”. Make the debit card charge
payable to Jesse’s Convenience Store for $28.47 and the charge happened on the 13" day of the current month. Inthe
Accounts section, enter Vehicle: Fuel as the expense account and Standard as the tax type.

. Enter a transfer from Chequing to Savings that occurred on the 10" of the current month. The transfer was in the
amount of $50,000.
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Lesson 4— Banking in QuickBooks Review Activities

It's time to reconcile the Chequing account! The bank statement you received has a statement ending date of
12/31/2018 and 178,608.75 as the ending balance. There were also $50 worth of service charges on 12/31/2018 and the
account earned $5.15 worth of interest. Make sure to indicate an appropriate income account for the interest earned,
such as Interest Income. All of the cheques/payments and deposits cleared so mark them appropriately and reconcile.

Find all the cheques in the sample file that were written for $3000.00 or more. How many cheques are there?

Enter a handwritten cheque for $195.45 using the 21 of the current month as the date using the Chequing 2
account. Use cheque number 1 and make the cheque payable to Accounting Cycle for the performance of accounting
services. Categorize the expense as Professional Fees: Accounting. Enter “Standard” as the tax code, and as a
memo, enter “Accounting for the month of November.”

Enter a cheque that is going to be printed out of QuickBooks for $187.34 using the 24™ of the current month as the
date and use the Chequing 2 bank account. Check "Print Later” so that the cheque can be printed in a batch with
other cheques later. Make the cheque payable to Insurance Experts. Categorize the expense as Insurance Expense:
General Liability Insurance. Enter “Standard” as the tax code, and as a memo, enter “General liability insurance for
the month of November."”

Enter a debit card charge by opening the Write Cheques. Choose the Chequing 2 bank account if it isn’t already
chosen. If “Print Later” is checked, uncheck it, and in the cheque number field enter "DEBIT”. Make the debit card
charge payable to Sheldon’s Software House for $45.28 and the charge happened on the 13" day of the current
month. Inthe Accounts section, enter Office Supplies as the expense account and Standard as the tax type.

It's time to reconcile the Chequing 2 account! The bank statement you received has a statement ending date of
12/31/2018 and $4549.05 as the ending balance. There were also $25 worth of service charges on 12/31/2018 and the
account earned $5.15 worth of interest. Use the Interest & Bank Charges: Bank Charges for the service charges
expense account and Interest Income account for the Interest Earned. Make sure to indicate an appropriate income
account for the interest earned, such as Interest Income. All of the cheques/payments and deposits cleared so mark
them appropriately and reconcile.
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